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Enhancements and revisions in Adagio PurchaseOrders 8.1C (2013.

Features 

♦ Added specification codes for the Price List from the vendor, document header and document detail
V46, Vendor price list code 
E96, Vendor price list 
D87, Item price list 

Problems Fixed 
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♦ If you chose Cancel on a Cancel / Retry message when posting a purchase order while blocked by another user posting at the same 
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♦ On the View tab, some Header, Bill to and S
purchase order did not show (although they were correct on the printed document).

♦ When single-segment item numbers are used, the item number field in details on documents poste
left-justified instead of right-justified. As a result, items were not found in the Item Transaction Inquiry function or the Purchase 
History for Item inquiry function from a detail in document entry. This
details posted in PO 8.1C as compared to documents posted in Purchase Orders for Adagio 8.1B. This has been corrected. The 
Data Integrity Check will correct existing details in the database. 
installing the PurchaseOrders 8.1C (2013.11.22) Service Pack
incorrect details. This is not a cause for concern. These errors will be rebuilt by the DIC without any problem or loss of data.

Adagio PurchaseOrders 8.1C     
PO20131122    2

Adagio® PurchaseOrders 8.1C (20

Release Notes  

date compatibility information is on the Product Compatibility Info

Adagio 
Crystal Reports® 8.5-B for Adagio 
DataCare 8.1A - 9.0A 
ePrint 9.0A 
GridView 8.1A – 9.1A 
Inventory 8.1C, 8.1D 
JobCost 8.1B, 8.1C 
Lanpak 9.0E 
Ledger 9.0C – 9.1A 

 
MultiCurrency 8.1B
ODBC 9.0A 
OrderEntry 8.1D
Payables 8.1D 
Purchase Orders for Adagio 8.1B
 
Other Products
MS Office 2003
MS Windows XP

Enhancements and revisions in Adagio PurchaseOrders 8.1C (2013.11.22) 

for the Price List from the vendor, document header and document detail: 

Corrected a problem that occurred intermittently at some sites when multiple users were editing PO documents. When a document 
was posted you received the error messaged "Error adding record to P/O Totals, record already exists." f

After this occurred, the Data Integrity Check (DIC) File Integrity Phase reported 
Totals and the Application Integrity Phase reported errors such as "Purchase Order is missing vendor totals record".

rebuild now corrects receipts with missing vendor Totals record (the DIC in the 8.1C (2013.09.13) 
Service Pack corrected the problem in purchase orders). The vendor document number will be set to "IR DIC DS". You should edit 
entries in the Payables invoice batch and enter the correct invoice number. 

When posting a document and while the mouse pointer has changed to busy, it was possible to click the X on the document windo
and get the message "Do you wish to cancel your changes?". Responding Yes to the question could cause e

If another user was editing a vendor when you posted a purchase order for that vendor, the posting completed when it should h
displayed a Retry message. This resulted in an incorrect amount in the P/O Balance field in the vendor. (This error was rebuilt by the 

Retry message when posting a purchase order while blocked by another user posting at the same 
time, in some cases the mouse pointer did not change back from busy to a pointer. 

When posting a document, if the New Document field was blank, the dialog closed and you were returned to editing the document
but the mouse cursor changed to busy (hourglass) and stayed that way. 

 a template or copying another PO, both the Extended Order Cost and the Extended Cost 
This caused a problem when a receipt was created because these field cannot be edited.

and Ship to fields were blank for a new purchase order and edits to these fields on an existing 
purchase order did not show (although they were correct on the printed document). 

segment item numbers are used, the item number field in details on documents posted in PurchaseOrders 8.1C were 
justified. As a result, items were not found in the Item Transaction Inquiry function or the Purchase 

History for Item inquiry function from a detail in document entry. This also caused a change in the way GridView views sorted item 
details posted in PO 8.1C as compared to documents posted in Purchase Orders for Adagio 8.1B. This has been corrected. The 
Data Integrity Check will correct existing details in the database. The first time the Data Integrity Check (DIC) is run after 

the PurchaseOrders 8.1C (2013.11.22) Service Pack, an error will be reported for each document containing 
This is not a cause for concern. These errors will be rebuilt by the DIC without any problem or loss of data.
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(2013.11.22) 

Product Compatibility Info link at www.softrak.com. 

8.1B 

D - 8.1F 
 - 8.1F (required) 

Purchase Orders for Adagio 8.1B 

Other Products 
MS Office 2003, 2007, 2010 
MS Windows XP, Vista, 7, 8, 8.1 

some sites when multiple users were editing PO documents. When a document 
" followed by "Error appending 
reported errors in the P/O 

s missing vendor totals record". 

(the DIC in the 8.1C (2013.09.13) 
The vendor document number will be set to "IR DIC DS". You should edit 

When posting a document and while the mouse pointer has changed to busy, it was possible to click the X on the document window 
and get the message "Do you wish to cancel your changes?". Responding Yes to the question could cause error messages and 

If another user was editing a vendor when you posted a purchase order for that vendor, the posting completed when it should have 
the vendor. (This error was rebuilt by the 

Retry message when posting a purchase order while blocked by another user posting at the same 

When posting a document, if the New Document field was blank, the dialog closed and you were returned to editing the document 

another PO, both the Extended Order Cost and the Extended Cost 
because these field cannot be edited. 

ds were blank for a new purchase order and edits to these fields on an existing 

d in PurchaseOrders 8.1C were 
justified. As a result, items were not found in the Item Transaction Inquiry function or the Purchase 

in the way GridView views sorted item 
details posted in PO 8.1C as compared to documents posted in Purchase Orders for Adagio 8.1B. This has been corrected. The 

tegrity Check (DIC) is run after 
, an error will be reported for each document containing 

This is not a cause for concern. These errors will be rebuilt by the DIC without any problem or loss of data. 
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♦ Receipts with multiple vendors continued to be shown on the 'Rcpts - All Vendors' tab after they were purged using the Purge History 
function. 

♦ The PO Designer now defaults email addresses to their full maximum length. The spec code 'V31, Vendor contact email address' is 
160 characters. The spec code 'V43, Vendor EFT email' (Telpay EFT Validation Email in the vendor) is 64 characters. 

♦ The 'Use secondary vendor' option in IC Item Vendor Check on the System Options tab in the Company Profile did not work. 

♦ If the Send To AP Reference Field on the Integration tab in the Company Profile was set to 'Vendor document no.' the field was 
blank for the first invoice in the AP batch and the number for the first document was sent for all other documents. 

♦ Purchase orders with a document number longer than 12 characters could not be emailed.  

♦ The "Printing completed." message displayed underneath the PurchaseOrders Printing dialog in some cases. 

♦ Auto-generated purchase orders did not default the Ship to code from Groups / Entry Templates. 

♦ Special characters where not accepted in the Document Number in Entry Templates, for example "PO#" used as a prefix. 

♦ In the 8.1C (2013.10.10) Hot Fix, tabs were missing in the Edit Item function. 

Installing 

To install Adagio PurchaseOrders you need the serial number and install code from the download instruction email sent to you by 
Softrak Systems. 

If you are installing an upgrade, you need the upgrade serial number and install code from the upgrade download instruction email. A 
previous version of Purchase Orders for Adagio should already be installed on your computer before installing the upgrade. If a 
previous version is not already installed, you can still install the upgrade. After entering the upgrade serial number and install code, you 
will also have to enter the serial number and install code from a previous version. 

Read the section ‘Upgrading to this Version’ below before installing an upgrade. 

If you are installing a Service Pack, you do not need to enter a serial number or install code. However, a previous version of Adagio 
PurchaseOrders 8.1C must be installed before the Service Pack can be installed. 

To install Adagio PurchaseOrders (or an upgrade), run the program file you downloaded. Once the install program is running you can 
click the View button to open the Readme file for detailed instructions. If Adagio PurchaseOrders is installed on a network, you must 
also do a workstation install for each workstation running Adagio PurchaseOrders. Refer to “Installing on a network” in the Readme for 
instructions. 

To install the Adagio PurchaseOrders Service Pack, run the Service Pack program and follow the instructions on the screen. After 
installing the Service Pack. A workstation install will not be required 

Adagio PurchaseOrders requires Adagio Payables and a Payables database must exist for PO to run. 

PurchaseOrders requires some Adagio modules to be at a certain version or higher. See compatibility information below or the 
Adagio Compatibility Chart. 

Adagio PurchaseOrders 8.1C requires Adagio Lanpak (if used) to be version 9.0E or higher. 

Adagio PurchaseOrders 8.1C requires Adagio Payables to be 8.1D or higher. If an earlier version of Payables data is detected an error 
message is displayed and PurchaseOrders will not open the database. Adagio Payables 8.1E or higher is recommended, as these 
versions support the new PO related fields in vendors. 

Adagio PurchaseOrders 8.1C requires Adagio Ledger (if used) to be 9.0C or higher. If an earlier version of Ledger data is detected an 
error message is displayed and PurchaseOrders will not open the database. 

Adagio PurchaseOrders 8.1C requires Adagio Inventory (if used) to be 8.1C or higher. If an earlier version of Inventory data is detected 
an error message is displayed and PurchaseOrders will not open the database. 

You will need to be running Inventory 8.1D and have installed the 8.1D (2012.05.12) Hot Fix if the following applies to you. PO writes a 
Sundry vendor code to an IC item if the company profile is set to 'Update IC primary vendor' when creating and saving a PO detail. The 
Edit Item function in IC verified the Vendor Codes against Payables only and forced a clear if the Vendor field was edited and it 
contained a Sundry vendor. Sundry vendors are now supported. This is not an issue in the Edit Item function in PO. 

Adagio PurchaseOrders 8.1C requires Adagio OrderEntry (if used) to be 8.1D or higher. If an earlier version of OrderEntry data is 
detected an error message is displayed and PurchaseOrders will not open the database.  

Adagio PurchaseOrders 8.1C requires Adagio JobCost (if used) to be 8.1B or higher. If an earlier version of JobCost data is detected an 
error message is displayed and PurchaseOrders will not open the database. 

PurchaseOrders does not have a Manual in PDF form. Use the online help instead. The help fully documents all aspects of the product. 



Adagio PurchaseOrders 8.1C     3 of 6 
PO20131122    25-Nov-2013 

Updating to 8.1C from the 8.1C Beta             Upgrade Complexity: Easy � 

To update to the release version of 8.1C from a beta version, you must install an upgrade to Purchase Orders for Adagio. See the 
Installing section above. 

Upgrading from Purchase Orders for Adagio version 8.1A or 8.1B             Upgrade Complexity: Intermediate � 

Do not install this upgrade until you are certain you have the versions of other Adagio modules required above are installed or 
are available to install. The upgrades to the other modules may be installed before or after installing the PurchaseOrders upgrade. 

You should perform a Data Integrity Check in your current version before installing the new version. Any errors should be rebuilt or dealt 
with in your current version before using 8.1C. 

Adagio PurchaseOrders (PO) will be installed to the \softrak\purchaseorders folder. Purchase Orders for Adagio (POA) was installed in 
\softrak\powin. Installing an upgrade from POA to PO does not uninstall POA and leaves the powin folder undisturbed. However, if the 
install detects that POA is installed it will inform you. You can use both PO and POA on the same database but cannot have the two 
programs open at the same time. If you have databases for multiple companies and do not want to convert them all at the same time 
you will be able to continue to run older versions of POA on those databases. 

Install Adagio PurchaseOrders in the same \softrak folder as Purchase Orders for Adagio. If this is not done, posting documents in POA 
will cause data integrity errors in PO. 

The upgrade install cannot change any custom icons you may have created to launch POA and they will continue to run that version. 
You must change these icons manually or create new ones to run PO from \softrak\purchaseorders\purchaseorders.exe. 

Adagio PurchaseOrders 8.1C does a minor conversion from Purchase Orders for Adagio 8.1A or 8.1B and may be installed at any time. 
The conversion does not affect running POA on the data. It only creates new files for its own use the first time you open an existing 
POA database. The message "This Adagio PurchaseOrders has security groups or Screen defaults that need to be converted... Do you 
wish to convert this data?" is displayed. Answer 'Yes' to be able to use PO, otherwise answer 'No' to continue using POA only and make 
no changes to the database. The conversion asks if you've made a backup and offers to make one. The conversion should take only a 
few moments. 

After converting your data to 8.1C, the program forces you to do a Data Integrity Check (DIC). All functions are disabled until a DIC has 
been performed. 

Adagio PurchaseOrders will run side-by-side with Purchase Orders for Adagio programs. That way, if you discover a circumstance that 
the new version treats differently, you will be able to use the old program without worrying about any data conversion while we address 
the discrepancy. 

However, PurchaseOrders 8.1C (PO) and Purchase Orders for Adagio (POA) cannot be used concurrently at the same time on 
the same database as this may cause data corruption. It is okay to use both products on a database, but you cannot have the two 
programs open at the same time. If you attempt to open PO when another user has POA open on a database, the error "Unable to 
obtain access to PurchaseOrders database, currently being accessed by [user name] in [POA<machine name>]." will be displayed. If 
you attempt to open POA when another user has PO open on the same database the error "An error occurred while attempting to 
create a task. The database is exclusively locked by another user. Please try again later." will be displayed. 

PO does not use and does not convert existing purchase order, receipt or other document specifications (.rtm files) from POA. They 
must be manually recreated. Start with templates in the PurchaseOrders Designer program or specifications from the sample data. PO 
includes default specification documents that are very similar to the defaults in POA. Many of the POA documents provided to Softrak 
by users/dealers were recreated for PO. You should be able to find document specifications that are close to the documents you use in 
POA. Your company logo and company address will need to be added, and other changes may be required. Spec codes may not be 
available for fields that were possible to print on documents in POA. 

PurchaseOrders does not convert existing POA Import or Export templates. However, the default templates from POA have been 
predefined as default templates in PO. Imports and exports from other systems using the POA default templates should therefore work 
without requiring changes to the files from the originating system. 

Security Groups in PurchaseOrders use the Adagio standard. The Purchase Orders for Adagio settings for menu choices are converted 
for use by PO. Other security settings in Groups are not converted and must be set up in PO as required. Note that POA security has 
levels of Low/Medium/High/System that PO does not have. If both PO and POA are used, settings in one do not affect the other. 

There are additional checks in the Data Integrity Check (DIC) in PO that were not done in POA. Therefore PO will likely find errors in 
databases where POA reported no errors. This is not a cause for concern and the errors can be rebuilt without loss of data. If you 
continue to post in POA, the DIC in PO may report new errors. DataCare will also detect and rebuild these errors. Running a DIC in 
POA may cause errors to be reported by PO. These errors can be rebuilt without loss of data. The DIC should therefore only be run 
in PO or DataCare. 

POA's day end will generate DIC errors in Adagio PurchaseOrders. It is therefore recommended that day end processes be 
performed in Adagio PurchaseOrders if you continue to use POA. Purchase Orders for Adagio was not properly completing PO's and 
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incorrectly calculates the Outstanding Balance on PO for a vendor. These DIC errors are detected and fixed in Adagio PurchaseOrders. 

PurchaseOrders is not compatible with ACCPAC® Plus™ Job Costing (DOS). If you are using Plus JC you must convert to Adagio 
JobCost before installing and running PO. It will not convert POA databases that are interfaced to Plus JC and will not open these 
databases. 

Note: The Edit Vendor and Edit Item functions now use a Lanpak license. If another user is already in Payables or Inventory this would 
require Adagio Lanpak to be installed. The view functions and sundry edits do not use a license, neither does adding a vendor or item 
"on the fly". Viewing vendors and items from within PO documents does not use a license but editing does. 

Adagio PurchaseOrders 8.1C installs a new Crystal Reports for Adagio table POW81. Custom reports created with tables for earlier 
versions should be updated to use the new table, although they will continue to work in most cases. 

GridView views originally created for earlier versions should be adjusted to use the 'Adagio PurchaseOrders 8.1C' dictionary (@U81C) 
to ensure that the information displayed is correct. Views used with GridView-RW MUST use current dictionaries to avoid the 
possibility of data corruption. 

Refer to the section 'Upgrading to 8.1C – converting custom reports and views' below for further details. 

After installing PO 8.1C, GridView will not show the 'Purchase Orders for Adagio 8.1A-8.1B' table when creating a new view unless you 
set the 'Show All Tables' option in Edit | Defaults. 'Adagio PurchaseOrders 8.1C' table will always be shown. As stated above, you 
should not be using Views created for POA once PO is installed. 

If you have Adagio ePrint, the message "Do you want to turn on Allow PDF printing for this dataset, and enable PDF Printing for all 
users?" will be displayed the first time you open a database. Answer Yes to save having to manually enable PDF Printing for each user 
in the User Preferences function. 

Upgrading from Purchase Orders for Adagio versions earlier than 8.1A        Upgrade Complexity: Difficult � 

PurchaseOrders 8.1C does NOT convert databases from Purchase Orders for Adagio versions earlier than 8.1A (i.e. versions 
from Purple Software Solutions). It does not convert databases from Inventory Receipts (IR) DOS databases or ACCPAC® Plus™ 
Purchase Orders (DOS). These databases can usually be converted but PurchaseOrders does not do this conversion. Contact your 
Adagio dealer or consultant if you need to convert these databases. There may be a charge for these services. 

Databases interfaced with ACCPAC Plus Job Costing need to be converted for use with Adagio JobCost before you convert to PO 
8.1C. A conversion program POAAJCvt.exe was installed by POA in \softrak\powin for this purpose. 

Upgrading to 8.1C – converting custom reports and views 

Reports 

The main Crystal table for Purchase Orders 8.1C is ‘POW81’ and replaces the 'IR65A' table for POA. Custom reports created in Crystal 
Reports for Adagio for POA with IR65A should recreated or convert using POW81. However, reports created for POA should continue 
to work without change as the data structure has not changed for PO 8.1C. Future release will require reports to be recreated or 
converted. 

Crystal Reports allows you to convert reports from one database to another by selection POW81 as an alias to IR65A. If any fields 
cannot be mapped automatically you can manually map those fields to the correct new field. 

Views 

GridView views originally created for POA using 'Purchase Orders for Adagio 8.1A - 8.1B' (PI80A) must be adjusted to use Adagio 
PurchaseOrders 8.1C' (@U81C). Views used with GridView-RW MUST use current dictionaries to avoid the possibility of data 
corruption. GridView 9.0A (2008.11.06) or higher has the ability to convert existing views when the dictionary changes with the release 
of an upgrade version of an Adagio module. 

The terminology in POA has changed from "Order" meaning a purchase order, to "Purchase Order" or "PO", to differentiate from an 
order in OE, which PO always refers to as a "Sales Order". The terminology has changed from "Price", meaning your vendor's price in 
POA, to "Cost", meaning your cost in inventory. 

Terminology changes for Order and Price have been made to field names in the data dictionary. GridView will not be able to convert 
fields in views for which the field name changed. For fields that cannot be converted you will see a message during the conversion. 
Note fields from the message and make adjustments to converted view as required. Columns that depend on fields that could not be 
converted will be removed. In formulas, fields that could not be converted will be changed to "Undefined Field". 

Changes and differences between POA and PO 

Although PO has virtually all of the functionality of POA, there are some differences to be noted including, but not limited to, the 
following: 
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PO does not have an option to create an intermediate batch for import to Payables. Day End always posts receipt and invoice 
transactions directly to a batch in Payables. If the option 'Direct batch posting to AP' was disabled in POA it will be enabled. 

PO does not have an option to create an intermediate batch for import to JobCost. Day End always posts cost transactions to a batch in 
JobCost. If the option 'Direct batch posting to JC' was disabled in POA it will be enabled. 

Standard Adagio Styles and Filters replace the document status coloring and selection scheme in POA. Styles and colors are applied 
by the conversion. Detail lines in documents color-coded for Contract, Price List and Complete using Styles. 

PO does not do Returns. POA did Returns although there were problems in this area. Use a negative Quick Receipt in PO to return 
goods. Returns entered in POA will not be processed by Day End in PO. 

PO does not use or need the Grid Mode (Extended or Quick) option found the Documents screen in POA. Use filters to change the sort 
order of the grid. 

Copy of POs and Requisitions is done from the Document List screen rather than with the Duplicate button in the document. 

The terminology has changed from "Order" meaning a purchase order in POA, to "Purchase Order or PO" to differentiate from an order 
in OE, which PO always refers to as a "Sales Order". 

The terminology has changed from "Price", meaning your vendor's price in POA, to "Cost", meaning your cost in inventory. 

Terminology changes for Order and Price have been made in the data dictionary and are visible in grids, finders, smart finder and 
Adagio GridView. 

Many ‘Alt-? key’ shortcuts have changed to accommodate new functions. 

Menus and the Toolbar have changed. Company Profile tabs and field positions have been changed from what is in POA. See the 
document 'PO 81B Company Profile options - Menus PO 81C.pdf, available on the Tech-Tips page on Softrak's website 
http://www.softrak.com/resources/adagiotips.php. 

The Restore function from History now copies a document to create a new purchase order (in the same way that OE Restore from 
history works), instead of moving back a collection of documents (PO, receipts and invoices) from History to Current in POA. 

PO generally has fewer pop-up warnings than POA. In some cases where there was a warning in POA the fields necessary to alert you 
to the warning condition are included on screens instead. For example, PO has a warning fields on details, such as * under stocked*. 

The Forms tab in Security Groups in POA does not exist in PO, however most setting from the tab can be achieved in PO. 

Reports are printed from individual menu choices rather than a Reports dialog of all reports. 

The Purchase order/receipt/return Listing is now called the Transaction Listing. 

The Outstanding Purchase Orders report has been redesigned. It is no longer that similar to the same report in POA. It is based on 
details and allows listing only outstanding items on partially received purchase orders. 

The Edit Item function in POA has a Pictures tab with 3 item images. PO does not have this. POA does not support the picture file on 
the Image tab in the Edit / View Items functions in Adagio Inventory, PurchaseOrders and OrderEntry. 

PO does not have the Statistical Analyzer function in POA.  

PO does not have or support the audit trail of changes to the Company Profile in POA. 

PO does not have the Compress DB function found on the Tools menu in POA. Use The 'Compact indexed files' option in DataCare 
instead. 

PO does not have a function to restore data from backup. Adagio modules do not include a restore function because there are many 
potential issues to be considered when restoring data. These include determining which backup to restore, which related data to restore 
or not, depending where you are in your accounting cycle with other modules, deleting the target data before restoring to prevent 
integrity errors, and ensuring you have a backup of the current data in case the backup file you are about to restore is corrupt or the 
restore is not viable for any reason. 

The Export function in POA includes a generic export feature allowing you to export most tables in the database. It exports to several 
formats. The Export function in PO supports only certain tables. To export other tables use the ExcelDirect feature from edit/view 
functions or the from the smart finder function. Or use Adagio GridView to export any table to Excel and from there to other formats as 
required. 

The Print Documents function in POA shows the vendor(s) for the selected document. In the case of multiple vendors on a document, it 
allows you select and multi-select which vendors to print. PO does not show the vendors, and if there are multiple vendors, documents 
for all the vendors are printed. However, the Send Method in the vendor (Payee/PO tab) controls whether a purchase order will be 
printed (not applicable to other types of documents). 

Email Covers are defaulted by user in POA, allowing them to be customized based on who is handling the purchase order. When a user 
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has access to the Email Setup, they are able to set a 'Default cover sheet' which is defaulted for that particular user. 

In PO, there is no Tax button on the Totals tab when editing documents like there is in POA. Instead of a Tax Button, PO has an Edit 
Tax check box on the Totals tab. Select the vendor you wish to change the tax for, enable Edit Tax and edit the tax for each Jurisdiction 
as required. The difference will be applied to the first detail line with tax. If no lines have tax the difference will be applied to the first 
detail. 

The Primary Vendor field for the purchase order has been moved to the top of the top of the screen on the Header tab to make it more 
prominent. 

Specification codes for printing Miscellaneous Charges as totals have been added. 

Transaction entry in POA has the option 'Always show Additional Item Information and Serial numbers' on the Details tab. PO always 
shows these lines. 

The 'Cost adjustment allocation' field in the Company Profile has been removed. The 'To GL cost of sales' setting did not work in POA. 
Therefore 'To remaining stock' is always used. POA has this option but it does not work. This may be implemented in a future release of 
PO when it no longer has to remain compatible with POA. 

PO does not have a Find function for details in documents. This will be implemented in a future release. 
 

-- end -- 


